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Quick Start Guide
Installation:

1. Visit  the AllsystemsMax Pro website and click the 'Price/Download' button
2. Click the 'Download Now!' button to download 'setup_AllsystemsMax_v9.n.n.n.exe'.
3. After download is complete click on 'setup_AllsystemsMax_v9.n.n.n.exe' found either at 

bottom left of the screen, or in your Downloads folder.
4. The first time you install AllsystemsMax Pro you must select 'Full Installation' and include 

the MySQL server. On additional workstations select 'Local installation, without MySQL 
Server'.

Overview:
AllsystemsMax Pro has a single homepage that remains active so that you never get lost within the 
program. Like most traditional Windows programs, there's a simple menu bar along the top of the 
screen which contains three drop-down menus. The menus are for activities that you only do once 
in a while.

Most of what you do each day is contained in the tabbed notebook, found below the menu bar. 

Work from left to right. The Schedule tab displays your current work in progress. Click the Start 
New RO button to schedule a new job. Assemble the customer and vehicle. Your new RO is opened 
for you in the next tab to the right, the Repair Order tab.

In the Repair Order tab, customer and vehicle information can be edited, and previous invoice 
history for the vehicle is also available. 

Assemble the repair order. Insert line items by clicking the Labor-Parts-Sublet button above the line
item grid. Pick from the lists or add a completely new item yourself. To edit a line item already in 
the grid, double click it.

Before invoicing, preview the repair order by clicking the Preview button.  Make sure it is complete
and accurate by seeing the job as it will appear when printed. The printed invoice format is similar. 

Then click the Invoice button to begin the invoicing process. Make some final decisions about 
additional fees, and discounts and then accept full or partial payment now, or post payments later.  



After invoicing a repair order, it is no longer in the Schedule tab. Instead, it will be found in the next
tab to the right, the Final Invoices tab. Final means final. Invoices cannot be edited, but a refund can
be created for all or part of the invoice. You can review and reprint invoices, and post payments on 
unpaid invoices here in the manner usually required for fleet accounts, that is, either by oldest first 
or on specific invoices.   

The next tab to the right, the Reports tab, helps you take full advantage of all the data you have 
collected, by providing an easy way to view results for any date range, either in spreadsheet view or
in formatted reports. In addition,  key indicators for your business are charted graphically. 

The date range selectors work the same way in the Final Invoices, Reports and Contact Manager 
tabs.

The Contact Manager tab keeps you connected with your customers, by generating appointment and
service reminders, as well as other  followup correspondence.
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The Menu Bar

The menu bar contains three drop down menus: File, Edit and Help.

The top section of the file menu manages multiple company data sets.

Create a new company by giving the company dataset a folder name. Then choose setup company 
to configure it, like this.

Select your active company here. Use the pre-loaded Sample Company for experimentation. 

This next section contains backup and repair, a simulated punching punch out timeclock, and a 
repository of saved spreadsheets.

Administrative utilities are only available to the program administrator who has the right password. 
Here the administrator can handle technical issues such  as mailserver setup, and sensitive issues 
such as assigning passwords that limit access to particular parts of the software. Also, the 
administrator can make corrections to inventory, the timeclock records, and very limited parts of the
invoice history.   

The edit menu provides an opportunity to edit lists of such things as customers vehicles, employees,
vendors, as well as labor, parts and sublet items.

Each workstation on multi-user systems can be customized here.

Last but not least, you create, review, and modify purchase orders here.

The help menu contains Internet links for remote support, extending your license, and a quick jump 
to the AllsystemsMax Pro website. Support phone numbers are also found here for easy reference. 
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The Tabbed Notebook (5 tabs)

tab 1: Schedule

AllsystemsMax Pro opens with the Schedule tab showing the schedule for today. If nothing is 
scheduled yet, then either click on another date or click on the search box (or Show All Dates 
button) to see all dates.

Continue your search in All Dates View by entering any part of the customer name or any of their 
phone numbers. Don't worry about the way your phone numbers are formatted. All characters 
except numbers are ignored. Just entering the numbers will be faster. 

In All Dates View, dates are color coded. Orange represents past, white represents today, and yellow
represents the future. 

The power grid is sorted by date but you can sort by any column by clicking on a column header..

Grouping, by dragging and dropping a column header on the grouping bar, will also help you to 
organize and locate scheduled work. See the Power Grid document for more about the grids used in 
AllsystemsMax Pro.

A repair order is selected by a single mouse click. A blue background highlights your selection, and 
makes it active.  The active R.O. is opened by switching to the Repair Order tab at any time, but a 
double mouse click will both select and then also immediately open it. We recommend double 
clicking; it's faster.

Note that if you switch to a single date from  'All Dates' view, there may not be any job highlighted 
even though there is still an active R.O., it's just on another single date not in view. The active R.O. 
always remains active until another one is selected. 

When returning to the schedule tab, from any other tab, the schedule automatically switches to 
single date mode for the scheduled date of the active R.O., with the active R.O. hightlighted.  

Enlarge the calendar by clicking on the double arrow found to the right of the calendar. This view 
provides additional information about your appointments. The days in the big calendar are clickable
and can be used to switch days, same as the small calendar. 

Rescheduling a Repair Order

Any changes to the schedule for the selected R.O.  is accomplished within the Repair Order tab by 
clicking on the Scheduling button. Upon returning to the Schedule, all changes are then reflected in 
the Schedule tab when returning to that tab. Changes to the customer or vehicle record are also 
made on the Repair Order tab, but if you want to edit a customer or vehicle that is not in the 
schedule,  use the Menu bar found above the tabs and click on the Edit menu, then 
Customers/Vehicles.  
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tab 2: Repair Orders

Overview

Repair orders are created by first clicking 'Start New Repair Order', on the Schedule tab. 

Then you select a customer...
 and then one of their vehicles...
 or add a new vehicle for that customer. 

If its a brand new customer, create a new customer by clicking the Add Customer button (top right) 
and then the +Vehicle button.

Selection of a customer and vehicle, causes the repair order tab to open, ready to accept line 
items,which you can insert in various ways. 
For example:

1. Click the Labor-Parts-Sublet button on the Repair Order tab, and then select from the list or 
else click the New! button.

2. Post parts from WorldPac SpeedDial catalog, if you have an account with WorldPac.
3. Post labor, parts and sublet from Similar jobs, that is, previously invoiced jobs on similar 

year make and model vehicles. In this case you simply pull items from old invoices.  

Packages aka 'kits'

 Clicking a labor item will also insert associated parts, when a package exists.  To create a 
package first make sure the Job Costing feature is on. The green light, indicating that Job 
Costing is on, is turned on and off by opening up Tools (gear icon found at the top of the 
Repair Orders tab), then toggling the Job Costing button. When you select a labor item 
followed by the associated parts, then click the group header (grey bar) directly above the 
selected labor and parts group, the Pack-it! Button will be enabled. Click the Pack-it button. 
This saves the package for reuse.  To modify a package, first insert it into a repair order.  
Delete or add parts, and then re-pack. If you remove all of the parts and repack the now 
solitary labor item will no longer be a package at all.

AllsystemsMax Pro comes pre-configured with a basic set of packages you can edit, the same 
way you edit your own packages. 

     

Estimates

                                                                                                                
Tagging jobs as estimates can help you control your workflow. It also helps you manage your 
stocked inventory by preventing double ordering. The recommended procedure is to start all jobs as 
estimates and then convert them to orders once the vehicle has arrived at your shop. 



A repair order can be changed to an estimate and vice versa by clicking the estimate-only checkbox 
in the top left-hand corner of the repair order tab. The estimate-only checkbox column itself helps 
you separate estimates and repair orders on the schedule tab.

In AllsystemsMax Pro there are only three differences between a repair order and an estimate: 

1. The printout will say either estimate or repair order at the top, in two places.
2. For repair orders, parts quantities sold from inventory are reserved and cannot also be sold 

on another job. For estimates, this is not true. If you only have one on the shelf, you can still
include it in as many estimates as you want. 

3. You cannot invoice an estimate. It must be converted to a repair order first.

Line Items

In  AllsystemsMax Pro, there are three types of line items you can add to your estimate or repair 
order: 
Labor... 
Parts...
 and 
Sublet. 

Each line item is identified primarily by an 'Item Number' of at most 55 characters, and secondarily 
by its 'Description', which can be as long and as detailed as you like. Labor can also have a 'Group', 
and parts can have both a 'Group' and a 'Location'. Group and location help you organize and find 
labor and parts if you have a very large number of listed items, but are not required. Ordinarily, 
doing a simple search, using the search box, is not only sufficient, but also fast and efficient.   

You can include an unlimited number of labor, part and sublet line items. However, you cannot 
have a labor item called 'radiator' and a part called 'radiator'.  Instead, use terminology for labor that
makes it clear the item is a service, such as 'Radiator – R&R'. If you don't use groups, you can still 
organize labor items by including standard group heading such as 'Engine, Transmission, Electrical,
Body,  etc., for example: 'Engine – Crankshaft – R&R'. The built in packages, included with 
AllsystemsMax Pro, use both groups and group headings. 

Sublet labor is an optional line item type, that has characteristics of both labor and parts. It's like a 
part because it is purchased from a vendor and requires a vendor name, but it is also often a service 
such as towing and machine shop work. Sublet labor can also be conveniently used for mandated 
charges such as State Inspections and Tire recovery fees. When both labor and parts are taxable but 
charges like these are not, set Sublet as non-taxable, and use it for no-tax items.    

Traditional Invoice Format or Subtotaling by Job- Your choice at all times

Estimates and Orders can be displayed in two ways:
1. Traditional format, grouped by labor, parts and sublet, listed in that order, with subtotals for 

each of these three groups. 
2. Grouped by each individually labor item with its associated parts and its own subtotal, with 

the labor items listed alphabetically. 



To switch between these two formats click the Job Costing button found in Tools (gear icon) at the 
top of the Orders tab. Grouping & subtotalling by each labor item is turned on when the green light 
is lit. Note that this button controls the format for all preview and printing of estimates, orders and 
invoices, not just the one currently being displayed on the Orders tab. It's a 'global' switch. 

Whether or not you are grouping by each individual labor item,  sublet items are always displayed 
in their own group. 

You can rearrange the order within each group by dragging and dropping the items. When 
subtotaling by labor item, you can also drag and drop parts from one labor item to another. 

More Advantages of Job Costing Format

As also mentioned in Repair Order 1 – Overview, with job costing turned on, you also have the 
ability to create, modify and delete packages, all sometimes referred to as 'kits'. This is one of the 
best ways to increase speed and convenience when assembling repair orders. A package is a single 
labor item plus an unlimited number of parts. In the labor list, kits are highlighted with their own 
background color. When labor is added to an estimate or order from any source, all its associated 
parts are also added automatically, using the most recently used vendor and pricing. 

Procedures

The Control Panel for the Repair Orders tab (lefthand green panel), contains buttons for activating 
repair order related procedures such as scheduling date and time, inserting comments, accepting 
prepayments,  handling authorizations required when  estimated charges are changed, previewing, 
printing, and invoicing.

Let's look a little closer at each of these, starting with scheduling:

Sheduling refers to the button used to access the details of a particular job, after it has been selected 
from the Schedule tab. 

If you assign a technician there, preferably before work is started, each individual labor line item
will be credited to that technician. Also, the technician initials will  automatically show in the right 
margin next to each line. Note that you can also assign a technician to each line individually, using 
the drop down combo box in the Technician column.

When its time to invoice, and still no technician has been assigned, AllsystemsMax Pro will prompt 
you for one, if that option has been turned on in Edit menu-> Service Writer/Workstation Settings 
-> Page 1, #7. 

The order status and vehicle status are useful in larger shops in which not everyone might be aware 
of the current state of work in progress, or the current location of the vehicle. Using order status and
vehicle status helps avoid situations where one person is waiting for or interrupting someone, just to
ask a question that can easily be answered by simply looking at the computer monitor. 

The type indicators, such as order type and customer type are used in the Profit Summary sales 



report. They help you discover how effective an advertising campaign may be, and where your 
customers may be coming from.

Ride Needed?

Ride details and Instructions are either displayed as a column, if included in the grid, or can be 
shown as an entire line by turning Instructions on using the 'I' button found at the top of the 
Schedule tab.  

Comments, printed on the repair order and invoice, can be assembled from a canned list, which you 
can modify at any time. Or you can enter whatever comment you like.

Prepayments are entered by clicking the Pre-pay button in the control panel on the Repair Order tab.
They can be updated or returned to the customer from here as well. When the repair order is 
invoiced, the prepayments are applied to the final invoice total before additional payments are 
accepted. 

Authorization for both the original estimate and any changes thereafter, must be recorded in some 
States... California, for example. Even if this is not required in your State, authorization can be 
turned on for you if you like by contacting Tech Support. 

Preview the repair order, before you start the invoicing process, to make sure that it is complete and 
accurate. Remember, invoices are final. An invoice is a legal contract between you and your 
customer. To keep it legal, and insure a valid audit trail, invoices cannot be edited after they are 
created, though refunds and credits can be issued against finalized invoices. 

Invoicing, by clicking the Invoice button at the bottom of the control panel, involves putting the 
finishing touches on the repair order, such as editing discounts and additional fees, and also 
correcting any last minute errors the software finds, such as missing odometer reading, and line 
items that have not been assigned to a technician. 

If you have any hesitation to finalize, then press Cancel. Otherwise, click the appropriate button to 
either finish by accepting a payment, or charging the entire invoice on account.    
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tab3: Final Invoices

There are two types of invoices, paid and not yet paid in full. The default view is all invoices. To 
group them by customer, drag and drop the Customer column header to the grouping bar above the 
grid. More about column grouping, sorting, sizing and placement can be found here in the Power 
Grid documentation. 

Check the Unpaid Invoices Only checkbox in the top left corner to see your accounts receivable, 
check balances and manage payments and credits. 

In either view, double click an invoice in the grid to view, reprint, export to pdf, or email it. 
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tab 4: Reports

Charts and graphs will display the key indicators for your business, for the selected date range.

Select a report from the column on the left. Some reports also have multiple sub-report choices.

Next select the date range by clicking any of date selectors. If you want a custom date range, first 
click on the year-to-date button, then choose a specific ending date, then a starting date. 

Next, either select all records by clicking the 'Select All' button, or click on a single line. Hold the 
Control key down and continue clicking to select more lines. Or, hold the Shift key down and click 
the beginning of a sequence of lines, followed by a click at the end of the sequence.   

Selected records can be printed as a formatted report. 

Selected records can also be saved to an Excel spreadsheet by clicking the Excel button. The 
spreadsheet will be loaded and shown on screen. It is also saved in the File menu -> Saved 
Spreadsheets.
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tab 5: Contact Manager 

Begin by selecting Contact type in the upper lefthand panel. 

Next select the date range or choose a specific ending date and starting date, from the pop-up 
calendars. 

Next, either select all recipients by clicking on the Select All button, or click on a single recipient. 
Hold the Control key down and continue clicking to select more lines. Or, hold the Shift key down 
and click the beginning of a sequence of lines, followed by a click at the end of the sequence.   

Often, you may simply want to view the list of recipients, but if you have a compatible spreadsheet 
program installed, the list can also be saved to an Excel spreadsheet by clicking the Excel button. 
The spreadsheet will be loaded and shown on screen. It is also saved in the File menu -> Saved 
Spreadsheets.

Semi-automated delivery of customer correspondence from the Contact Manager is by email, and 
optionally by text. With the Texting module installed, you can text appointment reminder, service 
reminder and other targeted messages. In addition, you can also send a general text message to a 
selected customer from the Schedule tab and Orders tab by first opening the gear icon (tools).
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Concepts

A. The Power Grid

In AllsystemsMax Pro, on each of the tabs, most of the information is displayed in what we call 
'Power Grids'.  'Power Grids', are a combination of rows and columns, as found in any spreadsheet  
program ...and the folder and file explorer in Windows. For example, on the Schedule tab, each row 
represents a single repair order or estimate. The columns represents attributes of that R.O. 

The power of 'groupable' spreadsheets

A hierarchy of groups and subgroups within a spreadsheet, increases the power to organize the 
information you are dealing with, so you can locate and display it in a more meaningful way. That is
the power of Power Grids. 

For example, the Schedule tab grid can be grouped by date... but you can group by any column by 
simply dragging the column header and dropping it on the grouping bar, located directly above the 
column headers. You can also have multiple grouping levels by continuing to drag column headers 
to the grouping bar. So another example would be to clear the grouping bar by dragging any column
headers that are already there back besides the other column headers on the grid. Then first drag and
drop the Date column header followed by the Technician column. As a result, you will have a 
separate list of jobs for each technician for each date in the calendar. 

Spreadsheet functions

Sort any column in the grid in ascending order by clicking once on the column header. Click again 
to resort in descending order.

Move an entire column by drag and dropping it in a new position in the column header row.

Resize a column by dragging the border line between column headers.  

Add and remove columns entirely by first clicking on Tools (gear icon) to open the column 
customize dialog box. The icon is 3 black columns with a red x in the top left corner of the icon. 
Any column header in the customize box can be dropped onto the grid in the column header,  and, 
vice versa, any column header on the column header row, can be removed from the grid by 
dragging and dropping it into the customize box.

Saving and Restoring Custom layouts

The layout of each power grid on each tab is always saved as the default, even if you turn the 
computer off, but you can also save five additional layouts for the Schedule grid by clicking the '+' 
button in Tools. It's located between the column customize icon and the 1-2-3-4-5 icons. Select a 
button number for your layout, and create your own fly-by hint to remind yourself what the layout 



is all about. The button number is linked to one of the 1-2-3-4-5 icons. Hover there to display the 
hint. Press it to restore the saved grid layout. 
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B. Inventory Control

Using the Inventory Control System in AllsystemsMax Pro you can: 

1. Know how much money you have invested in parts sitting on your shelves. 
2. Know where every part is at any given moment.
3. Stop spending money on parts you don't need on the shelf. 
4. Easily account for all parts purchases, either put directly onto a repair order, or else on the 

shelf. 
5. Track returns.
6. Track cores. 
7. Get timely information that can be used to handle warranties.
8. Check vendor billing.
9. Maintain optimal shelf quantities with minimum effort.

Most independent repair shops no longer stock much inventory and instead rely on vendors for on- 
time delivery of parts as needed. In AllsystemsMax Pro we call such parts 'Non-Stocked', as 
opposed to 'Stocked' parts kept 'On Hand' because they are more frequently used.  

In addition to stocked items on hand, 'Inventory Value' also includes 'Allocated Parts' and 'Returns'.

'Allocated Parts' are parts assigned to a vehicle for pending work or work currently in progress. 
Allocated parts are either parts taken from stock on hand, or 'Non-Stocked' parts that have been 
purchased for work in progress. A purchase of a 'Non-Stocked' part is confirmed by entering a  
'Reference Number' ,  that is,  a vendor invoice number, packing slip, or another vendor number that
can be used to trace the part back to its source vendor. 

Here is how the Inventory Control System manages both stocked and non-stocked parts on a repair 
order: 

You add part T022K, a timing chain kit, to a repair order. The software looks and finds T022K is 
not available on the shelf, so instead of leaving the reference number blank, as is done for 
'Stocked Parts', it inserts the reference number  '0(n)'  as a placeholder. Then, when you actually 
get your hands on the timing chain kit, you replace this placeholder with the actual vendor 
invoice number, thereby confirming purchase of the part. The software then automatically 
creates a purchase order using the reference number, receives it into stock (on the shelf), and 
then takes it out of stock (off the shelf) and assigns it to the particular vehicle, replacing your 
temporary entry '0(n) in the repair order.  All of this happens in a fraction of a second. All you do
is enter the reference number. The PO is handled automatically.   

Note that because you have now actually purchased the part, if you delete the repair order, you will 
need to deal with that timing chain kit you already bought. So, in that case, the software will ask 
you what to do with it. You can either put it on the shelf as a 'Stocked Part' in inventory, or return it 
to the vendor. 

Returns

'Returns' are parts that have placed in the virtual 'Return Bin'. Such parts are still in your possession 



but have yet to receive a return document number from the vendor.  Note that the return bin is not 
necessarily a physical bin or box. It's any location set aside for placing returns until either the 
Vendor comes to pick them up or you ship them back for credit.  

Returns are the opposite of purchases, in that you are essentially selling parts back to your supplier. 
Therefore, for simplicity, records for returns are included together with the purchase orders for each
vendor, but with negative quantities that are highlighted in red. 

Inventory Setup and Entry of New Parts

Now, let's look at the many ways parts enter parts into the system.

When first starting out with AllsystemsMax Pro, tech support can import parts lists from 
QuickBooks or Excel, and in some cases extract your inventory and vendor list from other shop 
management software. A fee may be charged for this service. 

After you are up and running, 'Non-Stock' parts are added to the repair order, and also to the parts 
list, by clicking the Labor-Parts-Sublet button in the Repair Order tab, selecting the Parts radio 
button, and then clicking the New Item button. After a part is in the system, if you want to stock the 
part, you can create a purchase order, submit it to the vendor, and then receive and post the parts 
when they arrive at your shop. On hand quantities can also be adjusted using the Administrator 
Utilities, found in the File menu. 

How Inventory onhand quantities increase and decrease

Onhand quantities in PRO are a count of what is expected to be found in the parts room, shelf, or or 
other permanent locations where you keep stocked inventory. To keep track, AllsystemsMax Pro 
does NOT require that you set minimum, maximum or reorder quantities. Instead, a simpler method
is used: You adjust the quantity you want to maintain each year when you do your physical 
inventory. Then you reorder what has been sold by using Report tab->Parts->Reorder Qty report. 
It's that simple.

Maintaining stock on hand

For items that you must reorder in specific package quantities that are greater than how much you 
might sell on an individual invoice,  you will need to make some adjustments to your order. For 
example, you may be purchasing oil by the 55 gallon drum but sell by the quart, so you will be 
waiting until you have sold about 220 quarts before reordering 1 more barrel.  For items like these 
you may want to skip the report altogether and just check your stock on hand and then reorder 
appropriately. Regardless, when you receive the order and post it, you must always post the receipt 
in quarts, or whatever unit quantity you bill out.

How on hand quantities can change, during the course of the day



Onhand 'Stocked Parts' quantity will decrease when:
1. the part is included on a repair order. The part is said to have been 'allocated' at this point, no

matter where it is actually physically located, or
2. the part has first been put on an estimate, and that estimate is then upgraded to a repair 

order, or 
3. the part is moved directly to the return bin from stock on hand by using the Returns button 

in Purchase Order menu. 

Onhand 'Stocked Parts' quantity increases when:
1. you create a purchase order to replenish sold quantities and then post it, when it arrives at 

your shop. The Reorder Guide found in the Reports tab in the Parts section, helps you create
the purchase order, or 

2. an allocated part is deleted from an R.O. and you choose to put it back on the shelf, rather 
than sending it to the return bin. This part is originally added either from stock on hand, or 
purchased on the fly, but is then deleted from the repair order, or on a repair that itself is 
deleted, or

3. a customer returns a part and you choose to put it back on the shelf, rather than sending it to 
the return bin, or 

4. a part is deallocated by downgrading a Repair Order to an Estimate. If the part was allocated
from inventory, it goes back to inventory. If it is a 'Non-Stock' part, whose purchase has 
been confirmed, then it also goes back into inventory. 

AllsystemsMax Pro will always first try to use up stocked quantities to fill repair orders before 
ordering nonstocked quantities 'on the fly'. So, you may find a part listed twice on a Repair Order, 
once for the quantity already available on the shelf, and then again for the additional quantity 
needed. Two lines are required to keep the inventory count and purchase orders accurate. 

The line representing a part sold from stock already on hand, will have a blank reference number. 
The other will initially have the vendor reference number '0(n), and then, when the part is received, 
it will then have the vendor reference number you enter to confirm the purchase. The n in 
parentheses stands for 'non-stocked purchase'. 

Purchase Orders

In order to manage the flow of parts, the purchase order system automatically combines both 
stocked and non-stocked purchases for managing payments in a 3-step progression of your 
purchases. These steps are:

1. Unposted parts. These are orders that have not yet been received. 
2. Posted, not paid. These are received orders that have not been paid for. 
3. Paid. This is a summary of purchase orders and payments. 

Purchase orders are found at the bottom of the Edit menu on the Menu bar. 

Inventory Core Handling

A core has the same item number as its parent but starts with the '&'. A core part is created 
automatically when a new parent is inserted into the parts list, by checking the Has A Core 
checkbox, and if not already existing, when adding a new item into an RO from either WorldPac or 
Similar Jobs. The only significant fields for the core is bill each. Cost each is assumed to be equal to



bill each. The description of a core is always 'Core' . All other fields, such as vendor, group, 
location, taxable, onhand, last cost, last sold, etc., are null. If a value is needed, for example, vendor,
then the parent value is used.

When inserted into an estimate or order, the bill quantity for the core is zero. AllsystemsMax Pro 
assumes that the core quantity is allocated in quantity equal to the parent by calculating parent bill 
quantity minus core bill quantity. The core bill quantity can be changed up to the bill quantity of 
parent, in situations where the allocated quantity of the core 'disappears' by being unsuitable for 
return or by being delivered to the customer, without replacement, in an over the counter sale. If 
unsuitable for return, the parts manager has the option of billing the customer for the core, or setting
bill each to $0.00, thus absorbing the vendor cost of the core deposit.

In all cases, cores will always be accounted for by being billed to the customer (perhaps at 
price=$0.00) or being sent to the return bin.

Core, in quantity equal to parent bill quantity minus core bill quantity, is sent to the return bin when 
the repair order is invoiced. Cores are never returned to the shelf as a separate entity that is not 
inherent in the parent. Therefore, the core quantity on hand is assumed to be the same as the parent 
and is not tracked or reported on, except by virtue of being seen in the return bin. 
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C. The Date Selectors

Date selector buttons are used in three tabs: 
Final Invoices
Reports
Contact Management.

There are four buttons:
Today
This week- Monday through Sunday
30 Days – The past 30 days, including today.
This Month – From the first day of the current month, up through today.
YTD  (year-to date) – From the first day of the current year, up through today.

Note: Any period can be selected by first clicking YTD and then entering an end date, then a 
starting date. By selecting the ending date first you will limit the date range, which may speed up 
processing, on very large reports.  
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D. The Tech Planner

The Tech Planner is a visual representation of the Schedule. It is similar to Google Calendar but 
fully integrated with estimate and repair order information you have already entered. 

If you are in the Schedule tab, double click any date in the upper lefthand corner to bring up the 
Tech Planner window. If you are in the Repair Order tab, click the TP button found to the right of 
the Vehicle and History buttons near the top of the screen. 

The Tech Planner settings can be changed by right clicking the empty blue square in the top left 
corner of the planner grid, near the 6:00am time slot. 

To start a new RO within the planner, instead of in the Schedule tab:
1. Use your mouse to drag across the desired time slot in the desired technician column or row.
2. With the slot highlighted, click the Start New RO button at the top of the Tech Planner 

window. 
3. Follow the remaining prompts for selecting customer and vehicle. 
4. In this way your new repair order is not only created but also scheduled in both the Tech 

Planner and Schedule tab.  
To reassign a repair order to a different technician within the planner simply drag and drop it where 
you want it. 

To change the time allocated to a scheduled repair order, grab the outside borders and move them in
the desired direction. The size will grow or shrink.  

To keep the allocated time but move the entire repair order to another starting time, left click and 
then drag the uppermost part of the square (where the start and end time is displayed) to a new start 
time. The entire square will float to the new position.  
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E. Mobile App

The AllsystemsMax Pro Mobile App is currently available only for Android smartphones and 
tablets. The app provides the opportunity to scan and decode VIN's, and also search for and display 
ownership information for vehicles that have previously been serviced at your shop. Vehicle and 
owner information can be edited, and new repair orders and estimates can be started by entering 
'quick intake' information and 'instructions'.   The changes you make on your Android device appear
immediately in AllsystemsMax Pro on your Windows workstations.

To accomplish this, your phone shares the same AllsystemsMax Pro database that connects your 
Windows desktops, laptops and tablets, by connecting to your router. So the first thing to do to set 
up your Android device is to make sure that wireless is turned on and that the wireless connection is
made.

There are two apps that need to be installed on your phone. They can both be downloaded from 
Google Play Store. They are both free:

1. MobileAllsystemMax  from AllsystemsMax LLC
2. Barcode Scanner from  ZXing Team  - Note that this app that is never opened independently.

It requires no setup or configuration. Just install it once, and then forget about it. 

After these two apps are installed on your Android device you are almost ready to scan your first 
VIN and start your first RO. 

But first you must set up your Android connection to AllsystemsMax. You only need to do this 
once. The REST Server is what lets AllsystemsMax 'talk' with your android device. It is a separate 
Windows program that opens and closes automatically when AllsystemsMax Pro opens and closes. 
It's icon is a red circle with the letters DX inside. It can be seen on the Windows task bar and is 

usually right next to the AllsystemsMax icon:

Click on the REST Server icon on the task bar to open it, so you can see its settings, and if it is not 
yet started, click the Start button:
 

Now, open the MobileAllsystemMax app on your Android device and enter the Host (IP) address 
and Port number so that they match the numbers on your REST Server. Then click the Connect 
button to test your connection. If you cannot connect, try changing the Port number from 8090 to 
8080 on both the REST server and the mobile app. On some systems 8090 or 8080 may already be 
in use. 



Mobile app screenshots:
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